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Using Write to View This Document

To make this document easier to read, you can enlarge the Write window to its maximum size. To 
do so, click the Maximize button in the upper-right corner of the window. Or open the Control 
menu in the upper-left corner of the Write window (press ALT+SPACEBAR), and then choose the 
Maximize command.

To move through the document, press PAGE UP or PAGE DOWN. Or click the arrows at the top 
and bottom of the scroll bar along the right side of the Write window.

To print the document, choose Print from the File menu.

For Help on using Write, press F1.

Technical Help

If you're having trouble running SimCity 2000 for Windows or are getting error messages (heaven
forbid!), here are some tips concerning these issues.  These tips were written by the Ninja 
Masters of Maxis Technical Support and contain enough information to make you an expert too.  
You may also be bored and want to make sure that we can actually spell and write documents 
with correct syntax.  Read on, O Seeker of Knowledge...

Installation Problems

On some machines, the SimCity 2000 installer may report a General Protection Fault after you 
enter the path where you wish SimCity 2000 to be installed. If this happens, try running SETUP 
with the parameter NO_CHECK. To do this, open your Program Manager, and in the File menu, 
select RUN.... In the Command Line box, type 

A:SETUP NOCHECK
(or if your 3.5" drive is your B: drive, type B:SETUP NOCHECK)

then click on OK.  You will get a warning that you are installing with the NOCHECK parameter 
specified -- this means that the installation program will not check to see if you have enough hard 
drive space free, or if you have enough memory to run the program, and will automatically install 
to C:\SC2K4WIN (the default directory).  Click on OK to continue with the installation.  By using 
the NOCHECK parameter, you will bypass the Registration Information, which is where the Mayor
Name that is used when creating new cities is stored. To change your Mayor Name, in the 
Program Manager, select File, and then Run..., and in the Command Line, type in NOTEPAD 
SC2K4WIN.INI, then click OK.  The second line will say Mayor Name=Installed With 



NO_CHECK.  Highlight this with your mouse, and type in your name.  If desired, do the same for 
Company Name.  When you are done, select the Notepad's File menu, and select Save, then 
File, and Exit.  Your copy of SimCity 2000 for Windows will now be registered to you.

System Conflicts

Conflicts are rare but they can occur.  If you are using other programs in Windows that load on 
startup, you may want to disable those programs to prevent potential conflicts and free up 
additional memory and system resources.  The most common potential conflicts come from 
screen savers.  If you are using a screen saver other than the default Windows screen saver, you 
may wish to disable it to prevent conflicts.  Some virus protection programs may also conflict with 
SimCity 2000.  If you experience trouble running SimCity 2000 for Windows, try disabling virus 
protection programs.

The best way to determine if there is something else running in Windows is to press the {Ctrl} 
and {Esc} keys on your keyboard at the same time.  This will bring up the Windows Task List.

The only item shown in the Task List window should be Program Manager.  If there are any 
other items shown, and you want to disable them, simply click on the item to highlight it and click 
on the End Task button to shut the other programs off.  If there are several programs running, hit 
{Ctrl}{Esc} again, and follow the previous steps.  Do this until only Program Manager is active, 
then close the Task List window.  Now run SimCity 2000 for Windows.

SimCity 2000 Crashes!
Some things you can try:
Increase the amount of low memory available in DOS. See your DOS manual for information on 
increasing the amount of memory available.
If you are getting occasional General Protection Faults in MMTASK or MCISEQ, you can try 
increasing the amount of buffers being allocated for sounds. To do this, open the Control Panels 
icon and select Drivers. In the Drivers window, there will be a list of items like "Timer" and "[MCI] 
Sound". Highlight "[MCI] Sound", and click on the Setup button. Usually, the MCI Waveform 
Driver Setup window will be configured for a 4 second buffer. You should try increasing that to 6 
seconds.

If the problem persists, you may need updated sound card drivers.  To verify this, in the Windows 
Program Manager, select File, and then Run..., and in the Command Line, type in NOTEPAD 
SC2K4WIN.INI, then click on OK.  In the [Options] section, you will see lines that say 
Sound=On and Music=On.  Highlight the word On with your mouse, and change it to Off in both 
lines.  Now, click on the Notepad's File menu, and choose Save, then File again, and then Exit.  
Now restart SimCity 2000 for Windows, and see if the error messages go away.  If they do, you 
will need to get updated Windows drivers for your sound card.

If turning off Sound and Music doesn't correct the problem, make sure that you have the most 
recent version of the video drivers for your particular video card. WinG will usually warn you if 
your drivers are incompatible, but SimCity 2000 may still have some troubles.

Cirrus Logic Chipset
Certain older drivers shipped with Cirrus Logic video cards may be incompatible with SimCity 
2000 for Windows. Make sure you have the absolutely most recent versions of the video drivers 
for your card or use the Microsoft Generic SVGA drivers, available on most online systems or 
from Microsoft.

Installing or Running with Windows Shells other than Program Manager

Shell programs are third party replacement programs that you can use in place of the standard 



Windows Program Manager, such as HP Dashboard, the Norton Desktop, and XSoft's TabWorks 
(which comes installed on most Compaq computers).  If you are having trouble installing or 
running SimCity 2000 for Windows, try either turning off the shell you are using, or using that 
program's File - Run command to run Program Manager.  The command line to run Program 
Manager is C:\WINDOWS\PROGMAN.EXE.  Once you have installed SimCity 2000, you should 
be able to close Program Manager and run SimCity 2000 through the shell program you usually 
run.

Some shell programs simply won't let you run SimCity 2000 for Windows properly.  This will 
depend on which shell you are running.  Once you have successfully installed the program, if you 
find that SimCity 2000 still won't run, try turning off the shell program you have been using.

A Special Note About TabWorks:  If you are running TabWorks on your Compaq computer, we 
STRONGLY recommend the following procedure to eliminate problems with extraneous icon 
creation and other bizarre problems.  First, use the Windows File Manager to delete the entire 
directory where SimCity 2000 for Windows is installed.  Then, go to the TabWorks Options menu.
Select File Tracking Options, and deselect (make sure there is no check mark) Track File 
Creation and Track File Modification.  This will allow you to install SimCity 2000 through 
TabWorks without having to run Program Manager.  Once you are reinstalled SimCity 2000 for 
Windows, be sure to select File, Save Book, or your Maxis Tab and icons may disappear when 
you exit and restart Windows.

Sound and Music

SimCity 2000 for Windows supports all sound cards that are compatible with Windows 3.1. If you 
do not have a sound card, you will not hear sound effects or music.

If you do have a sound card, check the Options menu while playing SimCity 2000.  There are 
two menu items in the Options menu called Music and Sound Effects.  For music and sound 
effects to play, both menu items MUST be checked.

Your sound card and its Windows software must also be configured for MIDI music in order for 
SimCity 2000 to grace your ears with its sonic beauty. To check this, go into the Accessories 
group and click on the Media Player icon. Click on Device and then MIDI Sequencer, and open 
the file CANYON.MID. Click on the triangular "play" button. If you hear music, all is well and good
in the land of the Sims. If, instead, you get some kind of error message (or worse yet, no error, 
but no music) we'll need to set up your sound card to play MIDI music. Your best bet is, as 
always, to contact the dealer where you purchased the sound hardware or the manufacturer, but 
we can offer some general suggestions.

First, you'll need a MIDI driver. This is VERY card specific, but we can at least verify its presence 
without much trouble. Go into the Control Panel, usually located in the Main group. Double-click 
on Drivers. We're looking for a driver with the word "MIDI" in it, other than just "MIDI Mapper" 
(we'll need that one in a minute.) Something like "Creative SB16 MIDI" or "Voyetra SuperSAPI 
FM MIDI Driver" is a good choice.

If you see it, we're doing fine; if you don't, you will have to install whatever software driver your 
card requires; check the manual and disks that came with the card, or again, with the vendor in 
question. The installation is just so system-specific we can't be of detailed enough help.

As long as the driver is there, go ahead and Close or Cancel the Drivers and we want to open 
up the MIDI Mapper (told you we need this one!) Click on the down arrow next to Name; ideally 
we need a "Name" that lists FM, FM Synth or FM Synthesized. If you can't find such a beastie, we
can likely make one. Click on Edit under Name. Each of the sixteen Ports should be set to 
something about FM; if they're not, click on the down arrow next to Port. We want to select 
whatever option we have about FM; again, "Voyetra SuperSAPI FM" or "SoundBlaster Pro FM 



MIDI" are the kind of thing we're looking for. Choose that option for each of the sixteen channels.

The reason we want "FM" rather than "External MIDI" is that these latter would talk to an external 
MIDI keyboard or the ubiquitous Roland MT-32 unit; but you would have to have such a gizmo 
outside the computer in order to hear anything. Instead, we use your sound card to emulate this.

We also recommend against running other sound-intensive applications (such as using the Media
Player to play audio CD's while you play SimCity 2000).

Video, palettes and pictures

What are Video Drivers?
Windows uses a set of programs called Video Drivers to control how it accesses your particular 
hardware to display things on the screen. Usually, the video card that you have installed in your 
machine will come with a set of video drivers that you can install for use with Windows. Windows 
comes with some video drivers that work on almost any video card and allow Windows to display 
16 colors at a resolution of 640x480 pixels.

What does this have to do with SimCity 2000?
SimCity 2000 was originally written for a 256 color environment. Since many people may only 
have the generic 16 color video drivers installed or may have video drivers for more than 256 
colors, we have allowed SimCity 2000 to run in color resolutions other than 256. Obviously, trying 
to run a program with 256 color artwork in 16 colors is going to look downright yucky. Additionally, 
due to the way many high-color and true-color cards work, some animations in SimCity 2000 may
not work properly with systems running in more than 256 colors. However, in both cases, SimCity 
2000 is still playable, so if you don't have 256 color drivers or are not sure how to install them, 
you can still play SimCity 2000 while calling your video card manufacturer or reading up on the 
documentation that came with your video card. For absolutely best results, we recommend that 
you run SimCity 2000 on a system configured for exactly 256 colors.

The steps to change the type of video driver you are using are system-specific; you may well 
have an icon in your Control Panel or even a separate group for setting and changing resolutions 
(screen size) and color depths (number of colors). We recommend that you check with your 
vendor or manufacturer for information on your display card, but here are some general hints and 
tips we can run through.

Find the Windows Setup icon, usually located in the group Main. Check what you are set to for 
Display. If it's just "VGA", that means 640x480 resolution (which is fine) but 16 colors (which we 
need to change). To change, you will likely need your original Windows disks, so keep them 
handy. Go to Options and choose Change System Settings. After clicking on the down arrow 
on the far right end of the Display bar, you'll want to scroll up and down to see the available 
selections. We want one that lists specifically 256 colors. If you do, select that setting, click on OK
and insert disks as requested. Let Windows restart itself (click on Restart Windows) and off you 
go. If the driver has already been installed, you may not need the disks and you can just select 
Current when prompted.

If you have Windows for Workgroups 3.11, you should see the option for "SuperVGA"; make sure 
to select one that lists 256 colors. "SuperVGA (640x480, 256 colors)" or "SuperVGA (800x600, 
256 colors)" should be good choices. This is a generic Microsoft driver that woks with many 
cards; though it isn't optimized for your card specifically, it should get you going. If you experience
problems with it, we would recommend that you obtain a driver that is specific to your card from 
your dealer or the card's manufacturer. This Microsoft generic driver is available through many 
shareware dealers or from Microsoft.

>>WARNING!!!  This is REALLY, REALLY IMPORTANT!!!<<
If you are running Windows 3.1, and you have not installed additional drivers specifically for your 



video card, the only 256 color drivers you will have with Windows are for Video 7 (512 KB or 1 
MB) video cards, XGA, or 8514a/b.  Unless you are POSITIVE that you have one of these video 
adapters in your system, do not select one of these drivers to configure Windows!  Doing so will 
most likely cause the problem below, and you may need to take rather extreme measures to 
change back to a useable video driver.  If you are going to try any video driver that you are not 
absolutely positive will work with your video card, and you are running a version of DOS older 
than MS-DOS 6.0, be sure you have a system disk that will fit in your A: drive, or your original 
DOS installation diskettes handy.

It is possible that after Windows restarts with the new driver that your display will blank out or not 
function properly. This indicates that you will need a specific driver for your card, but here's how 
to put things back the way they were. At the C:\> prompt, go to the Windows directory (type CD\
WINDOWS {Enter}) and then start the configuration program (SETUP {Enter}). Use the up arrow
to highlight the display, then hit {Enter} and scroll down to VGA. Go back down to Accept these 
settings... and off you go. 

Nevertheless, this driver will do the trick in the majority of cases and get you up and running; 
certainly, if you have it, it's worth a whirl. Again, there's always the SimCity 2000 Help file; just 
click on the question mark icon. It's got all kinds of groovy screen shots, for one version of 
Windows anyway, with pretty pictures to make sense of what we're telling you here.

You may also see a message from the Windows Graphics package, WinG. It runs a calibration 
test the first time it installs to optimize video performance. It may warn you that it is using a slower
method of video due to "an older version" of your video card software; SimCity 2000 and WinG 
will run for now, but we would recommend obtaining an updated version of your display driver 
(one that is WinG-friendly) at your first convenience, from the dealer or manufacturer of your 
video card.

Memory Issues

SimCity 2000 for Windows requires that you run Windows in 386 Enhanced Mode (Microsoft calls
it that whether you've got a 386, 486 or a Pentium).  You can check to see if you are in Enhanced 
Mode by choosing Help in your Program Manager, then going to About Program Manager...   If 
About Program Manager says you are in Standard Mode, exit Windows, then restart with the 
command WIN/3{Enter} instead of WIN. This will force Windows to start in Enhanced Mode.  If 
you cannot run Windows in Enhanced Mode, please verify that your system meets or exceeds the
minimum system requirements printed on the system requirements label on the box your copy of 
SimCity 2000 for Windows came in.

If you're using Windows for Workgroups 3.11, the only possible mode is Enhanced, so the 
About... box won't mention mode, just free memory. This is normal and cool.

If you don't have enough memory available to run SimCity 2000 for Windows, first ensure that you
close any other program that may be running to free up the necessary memory to run SimCity 
2000 for Windows.  If this doesn't correct the problem, consult your Windows manual and refer to 
the section entitled MEMORY.  There are several different options explained within this area, from
editing your startup configuration files to using Virtual Memory. 

Changing your startup configuration files
If you are running MS-DOS 6.0 or later, exit Windows entirely, and try running MemMaker at the 
C: prompt.  At the C: prompt, type in MEMMAKER{Enter}, and follow the prompts on your 
screen.  Use the Express Setup, and when you are asked if you use programs that use Expanded
Memory, say NO.  MemMaker will restart your computer several times, and load some or all of 
your device drivers into upper memory.  Once it is done, restart Windows, and try running the 
program again.  If you are using an earlier version of DOS, or are using PC-DOS or DR-DOS, 
refer to the section of your DOS manual regarding memory.  If you are still unable to start the 



program, in the Windows Program Manager, select File, and choose Run....  In the Command 
Line, type in NOTEPAD C:\AUTOEXEC.BAT, then click on OK.  This will open your 
AUTOEXEC.BAT file in Notepad.  Find the line that includes SMARTDRV.EXE (it will be either C:\
DOS\SMARTDRV.EXE or C:\WINDOWS\SMARTDRV.EXE, and may have a whole bunch of 
LH/1234/ in front of it).  If there are any numbers after .EXE, change them, or if there are no 
numbers there,  change the line to say:

[anything that was there] C:\DOS\SMARTDRV.EXE 1024 256 [any other options]
or

[anything that was there] C:\WINDOWS\SMARTDRV.EXE 1024 256 [any other options]

Once you have made this change, select the File menu in Notepad, and click on Save, then 
select File again, and click on Exit.  Now, exit Windows entirely, and reboot your computer (hit 
{Ctrl}{Alt}{Delete} all at the same time, then let them all go, or hit your Reset button, or simply turn
your computer off, wait about 10 seconds, then turn it back on).  Once you are back in Windows, 
try running the program again.

Using Virtual Memory
Virtual Memory actually uses your system's hard disk drive to temporarily store information that 
would normally be kept in the system RAM memory.  You may run Virtual Memory by following 
these steps:

(DON'T USE VIRTUAL MEMORY IF YOU ARE USING DISK COMPRESSION!
e.g. DoubleSpace/DriveSpace, Stacker, SuperStor, etc.  Most of these programs will come with 
their own utilities to use virtual memory, so refer to the documentation that came with your 
compression program for more information.)

1.  Open the Main window from within the Program Manager.
2.  Double-click on the Control Panel icon.  (This will open the Control Panel window.)
3.  Double-click on the Enhanced icon (the icon looks like a computer chip -- if it is not there, you 
are not running Windows in Enhanced Mode.  See the instructions above on how to start 
Windows in Enhanced Mode).
4.  Click on the Virtual Memory... button located on the right side of the window.
5.  This will open the Virtual Memory window from which you can view the current virtual memory 
settings.  You can increase the size by clicking on the Change button and increasing the size of 
virtual memory available on your system.
6.  Please see your Windows manual for more information concerning virtual memory.

If you have increase your Virtual Memory settings as high as Windows will allow, but you still don't
have enough memory free, you should probably exit Windows and run a hard disk optimization 
utility.  If you are running MS-DOS 6.0 or later, there is a utility included called Defrag.  To run it, 
exit Windows, and at the C: prompt, type in DEFRAG{Enter}.  When you have fully optimized 
your hard drive, try increasing your Virtual Memory settings again, and you should be able to use 
a larger Virtual Memory swap file.

REMEMBER there's always the SimCity 2000 Help file; just click on the question mark icon. It's 
got all kinds of groovy screen shots, for one version of Windows anyway, with pretty pictures to 
make sense of what we're telling you here.

Gameplay Issues

Loading SCURK tilesets
If you have SCURK installed, a new button will appear in the New Game window and a new 
menu option will become available in the File menu. These will allow you to load Object Sets from
the SimCity 2000 Urban Renewal Kit for Windows into SimCity 2000 for Windows. You cannot 
import .TIL sets from the Urban Renewal Kit for DOS - they must be converted in the Urban 



Renewal Kit for Windows. When importing an object set, only the tiles that exist in the set will 
affect SimCity 2000. If you have an object set with only 2 buildings (such as the Landmark object 
sets included on the SimCity 2000 CD-ROM collection), only those two tiles will be replaced in 
SimCity 2000 when loaded. 
When you exit and re-load SimCity 2000, it will try and read in the last object set you loaded 
before the last time you exited SimCity 2000. If it cannot find that object set, it will default back to 
the original object set.
You may load tile sets on top of object sets to create a completely original set, but when SimCity 
2000 is exited and re-launched, only the most recent object set will be loaded.
When loading object sets, you may get a message stating that you are low on memory. SimCity 
2000 will do it's best to clean up the memory available and give you a chance to exit any other 
applications you may have running in an attempt to create enough space to load the new object 
set. SimCity 2000 will keep loading objects from the object set until it does run out of memory, so 
you may end up with a city that has half original tiles and half new tiles.

Saved Cities

For your simulating pleasure, we have included several saved cities created by various Maxis 
employees. They are located in your SimCity 2000 directory.

Micro-Simulators 

When querying some structures, you get local statistics about that structure. For instance, 
querying on a Police Station will tell you how many crimes and arrests were handled by that 
station, and querying on a school will tell you how many teachers and students are attending that 
school as well as the average grade of the students. Most placeable structures (police, fire, 
schools, colleges, power plants, the Mayor's House, arcologies, etc.)have these micro-simulators.
Some structures share one micro-simulator for all the structures placed. Things like the bus 
system, railroad depots, marinas, libraries, windmills, and hydroelectric power plants among 
others have one micro-simulator for each category (one micro-simulator for all the bus stations, 
one for all the railroad depots, etc.). Where is this all headed, you ask? Well, each city can only 
have 150 microsimulators in it. If you go beyond that, the structure you place will still affect the 
simulator globally (police stations will still stop crime, bus stations will still carry passengers, 
arcologies will still hold people), but you just won't be able to see any local information on those 
structures. This isn't going to harm your city in any way. We're telling you this because it's pretty 
easy to run out of micro-simulators in a large city and we don't want you thinking something's 
wrong. 

Terrain Editing 

If you are building a city and go into the terrain edit mode, your city will disappear, but any trees 
or water that you have placed in the city will show up in terrain edit mode. Also, if you have placed
a bridge or other structure that automatically builds landfill, the landfill will also show up in terrain 
edit mode. These can be removed with the Lower Terrain tool. 

Airports 

Keep in mind when building an airport that it needs space for a runway, or it will not build. The 
minimum usable airport space is 2 x 6 tiles. Your best bet is to build the airport in 4 x 6 tile 
increments. And make sure no tall buildings are nearby; SimCity 2000 pilots are not known for 
their building-avoidance skills! In addition, make sure that your airport is blanketed with power 
lines. Airports may not initially build unless they are receiving power to certain tiles. 

Newspapers

If you are running low on hard drive space, you may experience a problem where multiple 



newspaper stories are open at one time.  You will need at least 300KB free hard drive space (on 
the drive that SimCity 2000 is installed to) before starting the game, and this will fix the problem.  
If you do get multiple stories, you can clear them by pressing {Enter}. If you are running into low 
memory situations, the Newspaper menu item may gray out.  Don't be alarmed; it won't hurt 
anything.

Importing Cities From SimCity Classic and SimCity 2000 Mac 

You can load saved cities from both SimCity Classic and SimCity 2000 Mac into SimCity 2000 
DOS. For importing purposes, SimCity Windows and SimCity DOS files are identical. To import 
SimCity Classic DOS and SimCity 2000 Mac saved games, rename the file so that the extension 
is ".SC2". If the file is from SimCity Classic DOS, SimCity 2000 will ask you if you wish to convert 
the file to SimCity 2000 format. The conversion will not change the original file unless you save it 
over the original file. To convert SimCity 2000 DOS files for use in SimCity 2000 Mac you will 
need to give the file a Filetype and Creator for the Macintosh. The Filetype should be "CITY" and 
the Creator should be "SCDH". This can be done with ResEdit, Access PC, or one of several 
other PC to Mac conversion utilities. SimCity Classic Mac cities must be imported into SimCity 
2000 Mac before they can be loaded into SimCity 2000 DOS. Not doing so will result in a "Not an 
IFF file" error message.
SimCity 2000 cannot read SimCity Original (the one with the Red Sheet copy protection) saved 
games. SimCity Original users can upgrade to SimCity Classic (which includes improved sound 
support) by contacting Maxis Customer Support at 1-800-33-MAXIS.

Keyboard Commands

Even though SimCity 2000 requires a mouse, there are several keyboard shortcuts that (with 
practice) can greatly enhance the SimCity 2000 experience.

The Shift key has several functions, depending on where you use it:
Holding down the Shift key and clicking on a tile in the edit window will have the same effect as 
using the Query tool on that tile.
Pressing the Shift key while placing a draggable item (Zones, Roads, Power Lines, Rail, etc.) 
BEFORE you release the mouse button will abort the placement of that object. (Note - You may 
have to move the mouse slightly while the Shift key is down for it to register.)

Holding down the Control key temporarily turns the cursor into the Bulldozer tool.
Pressing the Home key will zoom in one level on your city.
Pressing the End key will zoom out one level on your city.
Pressing the PageUp key will rotate your city to the right 90 degrees.
Pressing the PageDown key will rotate your city to the left 90 degrees.
The Cursor Keys will scroll your city.

Things fixed in version 1.2
You are currently using version 1.2 of SimCity 2000 for Windows. For those of you who have 
upgraded from version 1.0, here's what's new:

Improved Low Memory Checking
SimCity 2000 will now warn you if you don't have enough free memory to run reliably. Additionally,
low memory situations should be much more stable (but not totally - don't say we didn't warn you 
if you're running low and you crash!).

SCURK Compatibility
SimCity 2000 will now work with the SimCity 2000 Urban Renewal Kit, if you have it. SCURK is 
cool, go buy it.

African Swallow



At goinpoint, we forced the programmers to remove all safety settings and allow the user to select
the infinitely dangerous (and fast) African Swallow speed setting. Caution! Using this setting will 
cause SimCity 2000 to not draw any screen updates (well, ok, it draws them once every few 
game-months), not to time itself against your system's MCI clock, and may cause rips in the fabric
of the universe if used improperly. If you have selected this newly-declassified speed setting and 
a disaster occurs, SimCity 2000 will spit you out of Swallow mode so you can fight the forces of 
evil in real-time.

Several Dozen Bug Fixes
Including several simulator fixes, video card incompatibility fixes, terrain editing fixes, city editing 
fixes, some hardware compatibility issues (SC2k should run much better if you don't have a 
sound card. Sound cards are cool, go buy one.)

No, the Microsimulator limit is not "fixed". It's designed to be at 150 and will probably stay that 
way until the end of time. Sorry.

How to Reach Maxis Technical Support

What You Should Do Before You Call Technical Support

Before you call Technical Support, please be sure that you have read this Read Me file and any 
other appropriate material. When you are at your wit's end, scratching your head and grumbling, 
read on to find out what we would like you to have ready when you call, so that we can get you 
running as quickly as possible.  It will save both you and our overworked technicians lots of time 
and aggravation!

What You Should Have With You When You Call

1.  Have a print-out of your WIN.INI and SYSTEM.INI files as well as your CONFIG.SYS and 
AUTOEXEC.BAT files.  You can easily print all of these files by typing MSD {Enter} at the C:\ 
prompt.  This will run the Microsoft Diagnostics program which will allow you to print out a report 
of your system.  If you can't print out your system files (you don't have a printer), it isn't the end of 
the world, as long as you are at your computer when you call!  Make sure that your computer 
system meets or exceeds the requirements defined on the SimCity 2000 system label.  The 
system label is located in the lower-left portion on the front of the box.

2.  If you are getting error messages or General Protection Faults (GPFs), write down exactly 
what the error message says.  That will help us diagnose the problem.

3.  Write down all of the steps you have taken to solve the problem.  If we know what you've 
already done, we may be able to get you running faster.

4.  Have your program disks, your manual, and your Addendum available and within easy reach.

Where You Should Be When You Call

Please, please call us from your computer!  We need to have you at your computer to explore 
your system to identify what is causing your problem.

Let's Do the Numbers!

There are a number of different options that you can use to contact Technical Support. The first is 
by telephone, but this may not be the best option for you.  If you decide that you would like to call 
and hear a friendly voice, you'll find the number and hours of operation for Technical Support 
listed on the Maxis Maxims sheet, included in the box your program came in. There is lots of 
other useful info there, so keep your Maxis Maxims somewhere handy.



We are present on all of the major on-line services if you subscribe to any of these. If you don't 
currently subscribe, many on-line services will give you a 30-day trial membership.  Refer to the 
Maxis Maxims for more information on signing up. On AOL, just e-mail to "Maxis", or use keyword
"Maxis". On CompuServe, do "GO GAMBPUB" and leave a message in the Maxis forum.

NEW! Internet users! We can be reached on the Internet via e-mailing to 
SUPPORT@MAXIS.COM; we have a microscopic ftp site at ftp.netcom.com in the 
/pub/ma/maxis directory, which we are hoping to expand soon.

If you have a modem, on-line support is often a better option for you.  We maintain a BBS that is 
free-of-charge (excluding long distance charges from your phone company) to all registered users
of Maxis products.  The BBS number is (510) 254-3869 and it is available 24 hours a day, 7 days 
a week.  We support up to 14.4k bps and have four nodes. The settings are 8-N-1.  You can also 
find the latest FAQs (Frequently Asked Questions), hints and tips from other users and other good
stuff.

Introducing Maxis Technical Support...

Make sure you register your software!  We've included a handy little postcard for you to send in. 
This will entitle you to FREE Technical Support for the life of the product.  The product life ends 
when a new version is released or the product is discontinued.

And now what you've all been waiting for.  Here's a little bit about the support staff:  It just 
wouldn't be fair to give you all of this information without mentioning a little bit about the guys in 
Technical Support.  No, they didn't make or write the code and no, they didn't write the manual, 
but they do provide support for the product which far outlasts jelly doughnuts (and other 
comestibles).

Customer Support Manager:
Roger Johnsen
The Troops:
Joy Carchidi

Chris Charman
Shannon Dawes

Jeff Feil
Leo Kunkle
Lisa Laverty
Kirk Lesser

Owen Nelson
Aaron Shephard

Brian Smith

Also - Special Thanks to Kevin Endo and Simon Slavin for compiling the FAQs
and everyone who contributed to them (a list far too long to fit on this disk)
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